Welcome to SAi Flexi 12

The Flexi product group contains some of the world’s advanced tools for print production and sign
making software. We have added many new features based on your feedback.

Operating Systems Supported
e Windows 10
e Windows 8 32-bit (x86) or 64-bit (x64) processor
e Windows 8 Pro 32-bit (x86) or 64-bit (x64) processor
e Windows 8 Enterprise (x86) or 64-bit (x64) processor
e Windows 7 Home Premium 32-bit (x86) or 64-bit (x64) processor
e Windows 7 Professional 32-bit (x86) or 64-bit (x64) processor
e Windows 7 Ultimate 32-bit (x86) or 64-bit (x64) processor
Installing on a Mac using parallels or bootcamp is not recommended and not supported.

SAi Flexi 12 (SP3)
Build 2568
June 2nd 2017

Bug Fixes

e Fixed Hebrew fonts display issue, other translation issues

e Fixed Flexi Designer Vectorizing tools not active for some .jpg files

o Fixed Flexi Artwork Approval Tool not showing metric units

e Fixed EPS files not opening correctly in Flexi Designer

e Fixed Cut Condition sent incorrectly

e Contour line properties now saved as layers file saved as PDF/EPS

e Fixed image size varies after users adds crop marks

e Fixed job not finished successfully error

e Fixed issue with Spot White with RGB format

e Fixed crash when Job Info comments are very long

e Added Fotoba horizontal marks that also add a margin in between tiles on the same row

e Fixed Production Manager to maintain original color of contour lines in files

e Fixed Mutoh VJ-628x print issue

e Fixed Preview Window of the processed job so it appears in the preview section and not
one of the next jobs in the Hold queue

e Fixed HP L65500 giving an error message before printing process "Not enough Disk
space"

e Fixed Finishing Tools where the preview shifts after processing, one side of the bleed is
not printed and adding a bleed a small white margin is added

e Fixed Epson SC-S80600 error printing with vertical offset, using a custom (8-bit) profile
resulted in file format error



e Fixed objects disappearing or with gradient changing shape when sent from Flexi
Designer RIP and Print Dialog

e Added poll size option to multiple Mutoh VJ models

e Fixed issue with some gradients printing all white

e Fixed Summa OPQOS XY not printing correctly when color bar is turned on

e Fixed issue where Cut Preview did not indicate holes being cut first

e Fixed Summa S75T driver options velocity parameter miscalculation(1 mm = 2.5 mm)

e Fixed Hotfolders reverting back to default Jobs path

e Fixed cut jobs being sent to plotter out of order

e Fixed Summa D140R Always advancing after the plot

e Fixed "load HP Library fails" message when trying to add setup for HP T7200

e Fixed shadow in PDF file not printing correctly

e Fixed misplaced out file when using resolution 270x1440

e Fixed issue with Grommets not printing print when proportional box was unchecked

e Fixed Flexi icons to look bigger on hi-res monitors

e Fixed HP Z 31000 not printing from Flexi 12 Build 2324 (SP2)

Enhancements

e Added Flexi Knowledge Base — http://bit.ly/FlexiHelp

e Added ICC Media profiling wizard to Production Manager

e Added Roland Soljet Pro Il registration marks to Flexi Designer
e Add SummaFlex marks to Flexi Designer

e Added an icon for Send to EnRoute to the toolbar

e Added Animated Cut Viewer enhancements

e Allow moving objects relative to current position

e Allow group layers by condition

e Allow Cutting order by layers and cutting by layer

e Added Reset buttons on each cut/plot tab

e Added showing cutting direction

e Allow grouping of vinyl colors by condition

e Added spacing between horizontal and vertical copies

e Added ability to pause between specific colors / layers

e Added corner style to rectangular contour cut

o Added Advance After Plot, which allows the user to set a certain distance to advance
after plotting

e Added separate embedded ICC profile option per color mode

e Other miscellaneous improvements

New Features for Subscription Licenses


http://bit.ly/FlexiHelp

Added Cut Options per pass

Added DXF file dashed line recognition

Added close contours on import from DXF file

Added auto tile and smart nest in Flexi Designer

Added Cleave by Path and Vector Eraser Tool in Flexi Designer
Added set registration marks relative to media

Added check of only contour cut lines in Preview

Contour cut lines now include color specification

Added Unmask all

Added Interleave Copies

Enhancements for Graphtec Cutting Device Drivers

Expanded cutting area

Added Type 1 and 2 registration marks

Added Segment Area Compensation

Added Registration Marks Offset

Devices come with pre-installed media types

Added 2 and 3 points registration marks

Added Segment Area Compensation

Added Ul to show and change the cutter's identity number
Added new media sizes

New Printer Drivers

ADDTOP: ADD-KM512-14pl-5C-D, ADD-KM512-14pl-7C-D, ADD-DX5-5C-H, ADD-DX5-5C-
B, ADD-SE-4S--W, ADD-SE-4S--S, ADD-KM512-14pl-5C-B, ADD-KM512-14pl-7C-B, ADD-TE-
E-6C, ADD-SE-4S--W-8C, ADD-SE-4S--S-8C, ADD-TE-E1-6C, ADD-TE-E1-6C, ADD-TE-E3-6C,
ADD-TE-U1-6C, ADD-TE-U3-6C

AM.CO.ZA: FastCOLOUR F-1860 Eco, FastCOLOUR F-1620 Eco, FastCOLOUR F-1820,
FastCOLOUR F-1620, FastCOLOUR UV, FastCOLOUR DX5T Eco, FastCOLOUR DX5T Dye,
FastCOLOUR W5113 Dye, FastCOLOUR W5113 Sublimation, FastCOLOUR GT-DX5,
FastCOLOUR GT-W5

Aojet: Aojet H2512G, Aojet H2512K

ArtisJet: Artis-5000U

AShow: AShow_Ricoh, AShow_Toshiba, AShow_KM1024

AUDLEY: AUDLEY-4C, AUDLEY-6C, AUDLEY-NC-DX, AUDLEY-DX-4C, AUDLEY-S8, AUDLEY-
NC-DX-WV, AUDLEY-EP5113, AUDLEY-GEN5, AUDLEY-UV-D8

Avery: TrafficJet CM+Spot6

Azon: Indy UV Pro, Elektrojet, Indy DTS Pro, Indy Tex Pro, Edge, Soniq, DTS, Rotax, Hale,
Matrix Tex, Matrix UV, Matrix DTS, Matrix UV Pro, Matrix DTS Pro, Matrix Tex Pro, DTS
Grande



Bass Bowei: Bass Bowei-1610UV-G4, Bass Bowei-1610UV-G5, Bass Bowei-2512UV-GS5,
Bass Bowei-2513UV-G5, Bass Bowei-2030UV-G5, Bass Bowei-1610UV-GEN5

BOSSRON: WT-1802A-DX5, WT-1802A-DX7, WT-1802A-DX5113, WT-1700G-DX5, WT-
1700G-DX7, WT-1700G-DX5113, WT-3304L-5121, WT-3308-512I, WT-1325UV-G5, WT-
3300V-G5

Britomatics: Kingfisher BHYX

BYHX: BYHX-SG1024-5C, BYHX-SG1024-6C

Canon: imagePROGRAF PRO-1000, imagePROGRAF PRO-2000, imagePROGRAF PRO-
4000s, imagePROGRAF PRO-6000s, imagePROGRAF PRO-4000

CET: Color K Series

ColorlJet: Polo Turbo, Irislet, IRISJET PRO

Delone: Delone-KM-512-14PL, Delone-KM-512-42PL, Delone-KM-1024-14PL, Delone-
KM-1024-42PL, Delone-KM-1024-14PL-UV, Delone-KM-1024-6PL, Delone-KM-1024i-
13PL, Delone-KM-512i-30PL, Delone-DX5-ECO, Delone-DX5-Water, Delone-DX5-UV,
Delone-KM-512i-30PL-180, Delone-Ricoh2220-3PL, Delone-GEN5-7PL-Water, Delone-
GEN5-7PL-UV, Delone-DX7-ECO, Delone-DX7-Water

DIGIPRINTER: DIGIPRINTER-KM-512-14PL, DIGIPRINTER-KM-512-42PL, DIGIPRINTER-KM-
1024-14PL, DIGIPRINTER-KM-1024-42PL, DIGIPRINTER-KM-1024-14PL-UV, DIGIPRINTER-
KM-1024-6PL, DIGIPRINTER-KM-1024i-13PL, DIGIPRINTER-KM-512i-30PL, DIGIPRINTER-
DX5-ECO, DIGIPRINTER-DX5-Water, DIGIPRINTER-DX5-UV, DIGIPRINTER-KM-512i-30PL-
180, DIGIPRINTER-Ricoh2220-3PL, DIGIPRINTER-GEN5-7PL-Water, DIGIPRINTER-GENS5-
7PL-UV, DIGIPRINTER-DX7-ECO, DIGIPRINTER-DX7-Water

Digital Printer: TT-PC3200-4C, TT-6H-4, TT-6C-2-540 ECO, TT-6H-WV, TT-6C-WV, TT-6C-2
WV, TT-Toshiba-4-UV, TT-Toshiba-4, TT-4C WV

DYSC: DYSC-DX_A, DYSC-DX_B, DYSC-SK_A, DYSC-SK_B, DYSC-SK_B_G_W, DYSC-
LK_ADYSC, DYSC-DX_A, DYSC-DX_B, DYSC-SK_A, DYSC-SK_B, DYSC-SK_B_G_W, DYSC-
LK_A

DYSS: DYSS-GF-2616-12FRWRYV, DYSS-GH-1600-10FMW, DYSS-GH-2200-12FRWRYV, DYSS-
GF2630-16FMVMPFWW, DYSS-GM-6042N-CMYK_WYV, DYSS-GF-2616-12FRW, DYSS-GF-
2613-12FRW, DYSS-GH-2600-16SFW, DYSS-GH-2200-12FRW, DYSS-GH2200-4F, DYSS-GH-
2200-10FMW

EDAHIGHT: EDAHIGHT-SK_B_G_W, EDAHIGHT-LK_A

Ejet: Ejet-Locor, Ejet-Magic, Ejet-RICOH GN_5_195, Ejet-RICOH GN_5_130, Ejet-Single-1,
Ejet-Single-2, Ejet-Single-3, Ejet-Dual-1, Ejet-Dual-2, Ejet-Dual-3, Ejet-Dual-4, Ejet-RICOH
GN_5 6C_320, Ejet-EP6-SW, Ejet-EP-5X, Ejet-EP-8X, Ejet-EP-6X, Ejet-Single-4

Epson: SC-P800, SC-P807, SC-P808, SC-PX3V

ESS: ESS E 1601SW, ESS E 1802SW, ESS E 1804SW, ESS K 320SSW, ESS E 3204S SW, ESS
Q320S, ESS EUV 180 R and R, ESS KUV 180 Hybrid, ESS KUV 320 R and R, ESS QUV 320 R
and R, ESS KUV 320 Hybrid

Fabic: TX-1800

FANGDA TEX: FANGDA TEX-4C, FANGDA TEX-8C, FANGDA TEX-5C, FANGDA TEX-6C

Fei Yeung Union: FY-3212, FY-SPT1536GS-6C, FY-1012PS, FY-3212-35PL, FY-3212-50PL,
FY-2030A, FY-SPT1536GS-8C



Flora Texilte: Flora-Gen5Ink600, Flora-Gen5Ink605, Flora-Gen5UV360, Flora-Gen5UV363,
Flora-TJet100-8Gen5, Flora-GJet200, Flora-TJet200-8Gen5

Fortune: YF-2000D, YF-3200D, YF-3200UV, YF-W5113, YF-3200G, YF-3200G-S, YF-1700X,
YF-1700S, YF-1700XUV, YF-3200G-SUB, YF-3200UV-7, YF-2000D-7

Fujifilm: Acuity LED 1600

Gethray: Gethray-BYHX-EPSON_5113, Gethray-BYHX-EPSON_2-UV, Gethray-BYHX
KM512I-30PL-4C, Gethray-UMC Gen5, Gethray-UMC KM512i-30pl-4C, Gethray-BYHX-
KM1024-14PL, Gethray-BYHX-KM1024-42PL

Glitter: Glitter-DX7, Glitter-SPT35, Glitter-SPT50, Glitter-KM512i, Glitter-EP5113
HandTop: HandTop HT2512UV-R, HandTop HT2500UV-R, HandTop HT1610UV-R5
HuiFanTong: HFT-4C, HFT-6C, HFT-5113-3L

Helitin: HT-EP-Eco, HT-P500-Water, HT-P500-Eco, HT-FL1200, HT-PP400, HT-FP0405, HT-
FP0645, HT-FP0O609, HT-FP1209, HT-FP2513

HP: HP Latex 560, HP Latex 570, HP Latex 375, HP Latex 365, HP Latex 335, HP Latex 315,
HP Latex 1500, HP Latex 3500, HP Latex 3100, Designlet Z5600, DesignJet Z2600
HeXuan: HX-DX-YL, HX-DX-BH, HX-RH-BH, HX-LMHB-4C, HX-DX-YL-8C, HX-RH-W-BH, HX-
RH-DPS, HX-RH-RY, HongRun, HR-H5000UVK, HR-H3200UVK, HR-P2500UVK, HR-
F1800UVS, HR-T1800K

Human Digital: HM-H DX5 4C, HM-H DX5 8C, HM-H 5113-3L, HM-H 5113-3L 150D, HM-
DP 512-1024-14pl, HM-DP 512-1024-42pl, HM-DP 512i-30pl, HM-DP 512-1024-14pl UV,
HM-DP 512i-13pl UV, HM-DP 1024i-13pl UV, HM-DP 512i-13pl TEX, HM-D 1024i-13PL
TEX, HM-DP KM512i-1024i-6pl TEX, HM Q-JET Plus HM3200, HM-B DX5 4C, HM-B DX5
8C, HM-B KM256-42pl, HM-B KM256-14pl, HM-B KM512-1024-42PL, HM-B KM512-
1024-14PL, HM-B 1024-14PL UV, HM Combo-JET 4800, HM-B 1024-6PL UV, HM-B 512i-
13pl UV, HM-B 1024i-13pl UV, HM-B 512-1024i 13pl TEX

HYL Printer: HYL1501, HYL-UV-4C-WV-D2, HYL-UV-4C-WV-D3, HYL-UV-6C-WV-D2, HYL-
UV-6C-WV-D3, HYL-TX4C-D2, HYL-TX4C-D3, HYL-TX6C-D2, HYL-TX6C-D3, HYL-TX8C-D2,
HYL-TX8C-D3

InkJet Printer: InklJet Sign740, InkJet Sign1260, InkJet Dream740, InkJet Dream1260,
InkJet Pre740, Inklet Pre1260

Jetrix: RX3200, RX5000, RX320G

JingMei: JM-K1024-G-W

Keditec: Keditec-SG1024-12PL, Keditec-SG1024-30PL, Keditec-6C-150, Keditec-Gen5-
1CH-UV, Keditec-Gen5-2CH-UV, Keditec-Gen5-UV3200, Keditec_RICOH,
Keditec_Wrich_GENS5, Keditec-M3200UV-J

Kinglet: Kinglet-XAAR 1002-RY-8C, Kinglet-XAAR 1002-SD-8C, Kinglet-SG1024-BYHX-8C,
KingJet-XAAR 1002-RY-12C, KingJet-XAAR 1002-SD-12C, Kinglet-SG1024-BYHX-12C
KINGT: KINGT-1610, KINGT-2513, KINGT-2030, KINGT-4550, KINGT-4550C, KINGT-1010C,
KINGT-1016C, KINGT-4230C

LongKe: LongKe-Ricoh-UV2513, LongKe-Ricoh-UV2030, LongKe-Ricoh-UV1325, LongKe-
Ricoh-UV3040, LongKe-SPT1020-UV2513, LongKe-SPT1020-UV2030, LongKe-SPT1020-
UV1325, LongKe-SPT1020-UV3040, LongKe-Ricoh-4C, LongKe-Ricoh-6C, LongKe-Ricoh-



UV3200ROLL, LongKe-Ricoh-2530, LongKe-Ricoh-W, LongKe-Ricoh-UV5200ROLL, LongKe-
SPT1020-UV5200ROLL, LongKe-Ricoh-UV5200-10C, LongKe-Ricoh-10C

MARS: MARS EPDX5, MARS HS EPDX5, MARS BYHX KM512i-30pl, MARS UMC KM512i-
30pl, MARS HS W5113, MARS BYHX KM1024-14pl

Maxcan: MCC-GEN, MCC-GEN-B, MCC-GEN-C, MCC-DX-TX, MCC-GEN-4C-WV, MCC-GEN-
6C-WV

Metalnox: EPrint Strong Gen 5, EPrint Strong V2

Micolor: MC-5800, MC-5800D

Mimaki: JV33-160 OPALTONE, UJV55-320, UJF-7151, TS300P, TX-300P, JV33-1308BS, JV33-
160BS, JV33-260BS, CJV30-60BS, CJV30-100BS, CJV30-130BS, CJV30-160BS, TX-500B
Mutoh: VJ-1638UH, VIJ-1604X, VJ-1604WX, VJ-1938X

Mylet: Mylet_EPSON_UV, Mylet_EPSON_DX5S, MyJet_EPSON_DX7S, MyJet_EPSON_W,
Mylet XAAR382 35, Mylet XAAR382_ 60, MyJet KONICA512 42,
MylJet_KONICA512_ 14, MylJet_KONICA512i, Mylet_KONICA1024_42,

Mylet_ KONICA1024_14, Mylet_Starfire1024

NKT: Ceramic

Nocai: Nocai-UV-DX0406, Nocai-UV-DX0609, Nocai-RICOH2513, Nocai-UV-DX0609-NEW,
Nocai-UV-DX0615

OKI Data: ColorPainter E-64s (IP-5630), ColorPainter E-54s (IP-5530)

Oric: Oric GH2200, Oric DX5-2WYV, Oric DX5-B, Oric BE-1800

Polar: PL-1850, PL-1860, PL-1950, PL-1960, PL-3300

Polygon: HZ-DX5, HZ-DX6-3L, HZ-DX6-4L

PrintPretty: Niprint SF1024-4C, Niprint SF1024-8C, Niprint SM4C-1H, Niprint SM4C-2H,
Niprint AJ1806-UV, Niprint A6080T

PrismlJet: PrismJET VJ24, PrismJET VJ24X

REVOTECH: REVOTECH-KNE-TX, REVOTECH-KHE-TX, REVOTECH-KHE-6PL-TX, REVOTECH-
KM1800I-3PL

Ricoh: Ricoh Pro L4130, Ricoh Pro L4160

RIPControl: PRINTTYPE-SC-WF5113, PRINTTYPE-SJ-WF5113, PRINTTYPE-SC-XP600,
PRINTTYPE-SJ-XP600, PRINTTYPE-TC1932-X, PRINTTYPE-4180UV

Roland: TrueVIS VG-640, TrueVIS VG-540, SOLJET PRO 4 XR-640 OPALTONE, EJ-640,
VersaUV LEF-300, TrueVIS SG-540, TrueVIS SG-300

Saturno: Saturnolet

Saven: KinColor G5 RICOH-4C, KinColor G5 RICOH-6C, KinColor 3016SG

Shenou: Shenou FlatBed, Shenou HT, Shenou RICOH_WYV, Shenou RICOH

SID Signs: SID GALAXY TOSHIBA UV, SID GALAXY TOSHIBA ECO

SignStar: SignStar-SJP1902WF, SignStar-SIP3202WF, SignStar-SJIP1902E6, SignStar-TPW-
1902, SignStar-SJ3202V, SignStar-SUV3202, SignStar-GHR3208WN, SignStar-
GHR3208WN2

SinoColor: SignJet-SC1800, Signlet-SC3200, DreamlJet 740, DreamlJet 1260, Prelet 740,
Prelet 1260

Skycolor: STORMJET-XP600, FEDAR-TC1932-X, SKYCOLOR-4180UV, SKYCOLOR-Ricoh,
SKYCOLOR-ZT-XP600



e Titan: TT-PC3200-4C, TT-6H-4, TT-6C-2-540 ECO, TT-6H-WV, TT-6C-WV, TT-6C-2 WV, TT-
Toshiba-4-UV, TT-Toshiba-4, TT-4C WV

e Twinjet: Twinjet RH-1862, Twinjet RH-1864, Twinjet RH-1824, Twinjet RH-1826, Twinjet
SJ-1817Pro, Twinjet BYHX-DX5-8C, Twinjet BYHX-DX5113

e WanZheng: WZ-FRT2536KA, WZ-FRT2536KB, WZ-FRT2536GA, WZ-FRT2536GB, WZ-
FRT3225KA, WZ-FRT3225KB, WZ-FRT3225GA, WZ-FRT3225GB, WZ-FR3210KA, WZ-
FR3210KB, WZ-FR3210GA, WZ-FR3210GB, WZ-R3300KA, WZ-R3300KB, WZ-R3300GA,
WZ-R3300GB

e Xenons: Xenons DX-5113, Xenons M5, Xenons X5300RE, Xenons M5-W, Xenons 4740-H

e XinHaiSheng: XHS-2H-4C, XHS-2H-6C, XHS-2H-8C, XHS-1H-4C, XHS-1H-6C, XHS-1H-8C,
XHS-1H-UV, XHS-2H-UV, XHS-5C-UV, XHS-7C-UV, XHS-8C-TX, XHS-AURA-4C, XHS-AURA-
6C, XHS-AURA-8C, XHS-RM-4C, XHS-RM-8C, XHS-5113-8C, XHS-5113-3L-8C, XHS-
TX800UV, XHS-TX800UV-3L

o Xkeda: XLF_DX5DX7_150, XLF_DX5DX7_180, XLF_DX5DX7_HS_150, XLF_DX5DX7_HS,
XLF_DX6_HS, XLF_W5113 HS, XLF_CE4

e YUEDA: YD-1800-XE, YD-2513-RA, YD-3200-KC, YD-1510-RA, YD-3200-RC, YD-2600-RC,
YD-2600-KC, YD-1810-RD, YD-6090-RA, YD-1640-SF

e ZICHCUANG: FC-G5-4C, FC-G5-6C, FC-SK1020-4C, FC-SK1020-6C

e ZIER: ZIER-SPT-508GS, ZIER-DX7, ZIER-DX5, ZIER-SPT35, ZIER-SPT50, ZIER-KM512i, ZIER-
DX5113

New Cutter drivers

o AM.CO.ZA: AM-Generic DMPL, AM-Generic HPGL, V-Series V-850, V-Series V-1130, V-
Series V-1330, V-Series V-1660, V-Smart V3-440, V-Smart V3-740, V-Smart V3-1080, V-
Smart V3-1310, V-Smart V3-1660, V-Series V-360, V-Series V-800, V-Series V-1120, V-
Series V-1360, V-Series V-1700, V-Auto V6-900-AML, V-Auto V6-1500-AML, V-Auto V6-
1800-AML

e Aristo: TL1917, TL 1925, LFC 2332, LFC 2352, LFC 2372, LFC 3332, LFC 3352, LFC 3372,

LFC 5232, LFC 5252, LFC 5272, TL 19xx-C, GL 20xx-C, TL 13xx-C, TL 16xx-C, LFC 23xx-C, LFC

33xx-C, LFC 52xx-C

AZONColor: CC12W, CC24W, CC64W, CC59-AML

CAMFive: CFC-S24, CFC-548, CFC-S61, CFC-A75, CFC-A130, CFC-A165, CFC-AML

CutterPro-Auto: CutterPro-AML, Teneth-AML, TS-AML

CuttingPro: Servo-59L, Servo-1500L, CutterPro-AML

BannerCut: Bannercut 30cm LD, Bannercut 60cm LD, Bannercut 130cm LD, Bannercut

160cm LD, BannerCut-AML

Foison: S Pro-AML, S24 Pro, S48 Pro, S60 Pro, C60 PRO, FLAT BED, X-Series

e GMY: Flatcut-C

e Graphtec: FC4500-50/FC4550-50, DLP1000, FCX2000-180, FCX2000-120, FCX2000-60,
DLC1000

e Helitin: HT-P500-Water, HT-P500-Eco, HT-FL1200

e |CUTTER: S Pro-AML, S24 Pro, S48 Pro, S60 Pro, V60 PRO



INK SPA: CT-440L, CT-740L, CT-1300L, CT-1660L, CT-AML

King Rabbit: HX-AML-HPGL, HX-AML-DMPL

Mimaki: CFL-605RT, CF3-1610, CF3-1631, CJV30-60BS, CJV30-100BS, CJV30-1308BS,
CJV30-160BS

PIXELMAKER: PM-440, PM-740, PM-1300, PM-AML

POLARIS: POLARIS 440, POLARIS 740, POLARIS 1300, POLARIS 1660, POLARIS-AML
Roland: TrueVIS VG-640, TrueVIS VG-540, SOLJET PRO 4 XR-640 OPALTONE, TrueVIS SG-
540, TrueVIS SG-300

Servo Cutter: TS-AML, CC-AML, Servo-AML

Sign World: C60 PRO, FLAT BED, S Pro-AML, S24 Pro, S48 Pro, S60 Pro

Sky: N12, N15, N24, N30, N48, H12, H15, H24, H30, H48, D12, D15, D24, D30, D48, D12-
AML, D15-AML, D24-AML, D30-AML, D48-AML

SUCHI: SUCHI-AML

Summa: D160 SE

USCutter: TITAN3 28, TITAN3 53, TITAN3 68

Vicsign: Q3-AML, Q4-AML

Vinyl Express: EnduraCUT 3
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Bug Fixes

Multiple copy jobs sent to Grapthec GPGL no longer cut multiple times

PDF and EPS files with CMYK indexed images are now handled correctly

Fixed an issue with rendering of overprinted spot channels

Fixed an issue with Find File crashing when the searched folders have many hierarchies of sub-
folders

Fixed an issue where Flexi would crash when trying to load corrupted preferences

The list of File Types in Add Job is now displayed correctly

Registration marks are now applied correctly when adding nested print and cut jobs with Default
job properties set to center align

Cut options are now applied correctly on the Roland GX640

Fixed an issue with printing Spot Colors

Uploading jobs to the Approval tool in metrics will now display correctly on the customer
website

Fixed an issue with simultaneous printing to HP Latex 200 and 300 series

New Printer Drivers

HP: Designlet T7200, Designlet T3500, Designlet T730 36, Designlet T830 36, DesignJet T930 36,
DesignJet T1530 36, Designlet T2530 36, PageWide XL 8000, PageWide XL 5000, PageWide XL
4500, PageWide XL 4000



Epson: SC-S70675, SC-S50675, SC-S30675, SC-P600, SC-P20000, SC-P10000, SC-P20070, SC-
P10070, SC-P20080, SC-P10080, SC-P20050, SC-P10050, SC-S40600, SC-S60600, SC-S40610, SC-
$60610, SC-S40670, SC-S60670, SC-S40680, SC-S60680, SC-S40650, SC-S60650, SC-S80600, SC-
$80610, SC-S80650, SC-S80670, SC-S80680, SC-F6070, SC-F6200, SC-F7200, SC-F6270, SC-F7270,
SC-F6280, SC-F7280, SC-F9270, SC-F9280

Mimaki: TS30, TS500P, JFX200-2513

Mutoh : VJ-1324X (Valuelet), VJ-1624X (Valuelet), VI-1624WX (Valuelet), VJ-1924WX (Valuelet),
VJ-2638X, VJ-1938TX

Roland : XT-640, VersaEXPRESS RF-640A

New Cutter Drivers

Comagrav: Comagrav
Mimaki : CF-0907-2-S, CF-0912-2-S, CF-1215-2-S, CF-1218-2-S

SAi Flexi 12 (SP2)
Build 2253
30 September 2015

Bug Fixes

Labels containing Japanese characters now print correctly

Re-arranging production manager queue columns now displays the data correctly

Fixed an issue with the Bitmap Pro driver containing black dots in white underbase and fill
Fixed a crash that might occur when using rational angled screen with CMYKLcLm color modes
Files containing spot colors with empty names will now print correctly when sending from the
RIP and Print dialog

Default Job Properties tabs for hybrid devices now display correctly

Fixed a crash that might occur when sending a print and cut file with masks

QR codes now display and print correctly

Fixed an issue with sending icc profiler targets in RGB 8 bit mode

Profiler will now ignore presets that were set in default job properties

Fixed a crash that might occur when combining stochastic dither with 3x4 resolutions
Combining purify gray with CleanColor no longer prints too light

Brand name of Hewlett Packard setups has been renamed to HP

Fixed a crash that might occur when using a background fill on grouped and locked frames
Duplicate setup in SE now work correctly

Fixed an issue with the French translation of certain menu items not displaying correctly
Production manager device icons have been updated

Color bands with SO Diffusion and Smooth Gradients now print correctly

Fixed an issue where certain PDF/PS would rip slower if the ignore overprint option was
unchecked



e Cut after printing now works correctly on hybrid devices
e Fixed an issue with hybrid devices using registration marks where sometimes the bottom line of
a contour path was not cut

New Printer Drivers

e HP: Scitex FB550, Scitex FB750
e Roland : VersaStudio BN-20 ECO-SOL MAX3
e Lecai: LC-G5 Flag Printer, LC-Deluxejet 185G+, LC-Deluxejet 325G+

SAi Flexi 12
Build 2240
29 July 2015

New Product Levels

Flexi 12 has a completely new product line up that replaces the previous product levels and is better
tailored to your needs

o FlexiSIGN&PRINT
This SAi flagship product offers the total solution for print, print-and-cut and direct-to-vinyl
production workflow. It includes a powerful production manager with a complete wide-format
production feature set as well as a complete design application that makes sign and print design
easy.

® FlexiPRINT
This product has everything wide-format print businesses need for easy print and print-and-cut
production. In addition to versatile nesting and tiling features, it also includes banner finishing,
textile step-and-repeat and spot color matching and more. Also enjoy the industry's most
seamless print-and-cut workflow that allows you to add multiple contour cut lines to any design
in the fewest steps.

e FlexiSIGN
This product has everything professional sign makers need for direct-to-vinyl design and cutting.
It includes full graphic design, text serialization and color tracing features. It also has drivers for
over 1000 cutter models and unique features to optimize cutting speed and make weeding faster
and easier.



New Design Features

e View and change object order. Flexi now lets you reorder the objects more intuitively, by
selecting the objects in order, as well as having the option to optimize cutting start points. Access
this feature via Arrange > Cut Order > Reorder.

e Preview how a job will be cut in the Animated Cut Viewer. Go to Arrange > Cut Order > Preview.

e You can now open and import multiple files at once. When you open multiple files, an .fs file will
be created for each. When you import multiple files, your cursor will show a bounding box for
each file. Click to position the first one, then click again to position the next.

e QR Code is now available for non-subscription users.

e 2D Data Matrix codes have been added. Type in text and select Text > Data Matrix > Text to Data
Matrix.

e Artwork Approval Tool. Send Artwork out for approval to your customers before producing.
Your customer will receive a website link to view the artwork you created and will be able to
either add comments or approve. You can upload several revisions and monitor the status of
each Artwork Approval Task. Create a job and select File > Send to Approval Tool to get started.
Access the overview of all Approval jobs via the Job Approval icon in the Cloud window.

e Added True Shape Nesting for images with Contour Paths.

e Drawing placeholders for templates can now be scaled non-proportionally.

e The Send As E-mail feature now has a ‘selection only’ option.

e Flexi now supports TIFF files in planar format.

e The SummaFlex Swatch Library has now been added to Flexi.

e Cloud File Storage has been increased to 5GB.

New Production Manager Features

e Updated Look and Feel. All levels of Production Manager now have a thumbnail preview in the
queue for the selected job. All printing levels have a separate Hold, RIP and Output queue.

e Nesting Alignment Tools. Production Manager now allows more control over nested jobs. You
can now select multiple jobs in a nest and align them either relative to each other or relative to
the media edges.

e Apply Same Size to nested jobs. Select multiple files in a job nest and hit the Same Width or
Same Height icons on the layout tab of Job Properties.

e Banner and Canvas finishing tools are now available to non-subscription users. Add grommets,
fold and bleed to your jobs.

e Rectangular grommets and bleed option for corners of mirror and repeat bleeds have been
added to the Finishing tools.

e Choke and Bleed. For color modes containing spot ink channels such as white or metallic, you
can now define Choke or Bleed. Access this feature by selecting a color mode with a spot ink
and hitting the Choke button.

e Smoother Gradients. Access this feature on the Color Management tab of Job Properties dialog
or RIP and Print dialog. Gradients in EPS/PDF print jobs will be processed at a very high gradient
precision, which will especially have an effect on lighter gradients rendered at larger sizes.



Improved Pure Hue tool. Pure Hue can now be applied to all Primary and Secondary colors as
well as to Gray, as well as achieving better transitions with neighboring colors.

CleanColor™ provides an alternative pure hue method. Whereas standard pure hue bypasses
color management and will keep input values as output, CleanColor™ first processes the color
through ICC profiles and will then remove any channels that might have been added. This
method may achieve more balanced colors than standard pure hue.

Tiling settings can now be saved into Default Job Properties and presets.

PANTONE Plus Libraries have been added to Production Manager Global Color Mapping. The
choice between old PANTONE values or PANTONE Plus can be set in the Global Color Mapping
dialog. PANTONE Plus is now set as default.

Automatic gradient recognition for legacy EPS files. Older .EPS formats were not capble of
storing gradients as vector objects and converted them to bands. This feature which can be
switched on/off in Preferences will automatically recognize one of these band gradients and
convert them back into vector gradients, for smoother output.

Anti-Alias Text. This feature applies extra anti-aliasing to text in EPS/PDF jobs and was added
especially to improve the look of very small and fine text. When checked, it will apply to all text,
even large but the effect will be mostly noticeable on smaller text.

Find printer for TCP/IP. When adding a new printer in Production Manager with a TCP/IP port, it
can now search the network to find available printers and their TCP/IP address. Access this
feature by hitting the Find Printer button when adding a new setup. Not all printers support
being polled for their IP Address.

Eliminate line segment overlap for contour jobs. When 2 cut lines overlap, Production Manager
will only cut the line once.

Added printing Tile Trim Lines to make it easier to cut long tiles to assemble, especially with
white in the background, where the tile edge is difficult to see. You can access this feature from
the Print Marks drop down menu on the Labels and Marks tab of Job Properties once a job is
tiled.

Optiscout is now supported.

Added support for Rasterlink 6 to send print and cut jobs as single .eps files.

Added support for the SpyderPrint Spectro.

The Summa F-Series SummaFlex is now supported. SummaFlex Mark Options allow you to
control mark size and amount, the distance between job and marks. Switch on barcodes for
camera or for hand scanner.

Improvements and Bug Fixes

Design

PDF with Type 3 fonts are now imported correctly
Fixed an issue with drop shadow on capital A letters in certain fonts

PDF export of jobs with composites that contain a path with cut contour attribute now works
correctly

Rhinestone paths will now be kept after applying path editing tools such as scissor and cleaver
Improved spell checker for files with a very large amount of text objects



Fixed an issue in DesignCentral for outlines and shadows where sometimes the Apply message
would be lost

Copying bitmaps from Firefox to Flexi now works correctly.

It is now possible to assign a different color to QR and Data Matrix codes

Flexi will now automatically detect the location of the Adobe PhotoShop CC Plug-in folder

The default monitor profile has now been set to sSRGB

It is now possible to select another bitmap when using the bitmap fill tool without needing to
exit the tool first between switching bitmaps

Archive to Cloud will now wait until the upload of one file is completed before allowing a next
upload

Fixed a crash when using the bitmap eraser tool on a transparent bitmap to erase to original
PDF files containing masks with winding fill are now imported correctly

Fixed a crash that might occur when loading certain .fs files containing spot color mapping
Contour cut objects with fill only and no strokes are now displayed correctly

Fixed an issue with generating underbase white for TIFF or JPG

The alternative colors for exporting Pantone to PDF will now be calculated based on LAB values
instead of the base colors

.sci files now open correctly

In the Arrange > Nest tool, the default panel height is now set to the document height

The Color Mixer out of gamut alert is now based on Deltak 2000 larger than 2

Open paths in PDF files with a fill and only 2 points will not be closed automatically on import
Improved the display of PANTONE color gradients in soft proofing

Added export to Flexi 8.0 format

Fixed a crash that might occur when opening .fs files containing shared brush items for outline or
shadow

Sending a design that has a pattern brush with a transparent bitmap to a desktop printer no
longer crashes

Palette View is now working correctly

Fixed a crash that might occur when creating outlines for very complex paths

If the color of a cut contour path is not one of the CutContour spot colors, Flexi will
automatically assign a CutContour spot color upon export to .EPS

PDF based Al files can now be imported as linked

Custom changes in Casmate workspaces are now saved correctly

Fixed an issue with importing PDF files containing pattern fills with column spacing that is very
close to -100%

Fixed an issue opening complicated .fs files with nested effects

Layers now import in the order specified in the original document instead of alphabetically
Fixed an issue that sometimes thumbnail images were not generated when saving .fs files

fs files with dash pattern strokes now load the dash pattern correctly

After archiving a file to cloud, Flexi now prompts to save the file locally before exiting
Auto-place on import now uses paste offsets specified in the Preferences dialog

Meter limits are now kept on the inside paths for strokes when importing .ai files

Fixed an issue importing PDF X4 files with PANTONE spot colors



Zoom center now updates correctly with pan scroll
License Manager shortcut is now available in the Program Groups

RIP&Print and Cut/Plot

Custom Spot Color mapping is now applied correctly when sending files with spot colors from
the Rip and Print dialog

Jobs sent from Flexi Rip and Print as Send Now will no longer be on hold when the Autoload
Preview option is switched on in Production Manager preferences

Flexi RIP and Print now remembers media size changes for the next job

The list of ICC profiles now loads faster on the RIP and Print dialog when there is a long list of
profiles

For contour cut jobs, when the cutter is smaller than the printer, Flexi will only alert once about
the difference in size instead of with every job

The Cut/Plot and RIP and Print dialogs now remember user defined options when opening a new
document

Masking paths that are used as cut contour paths are no longer being skipped for cut output
The RIP and Print dialog will now use the cut mark options that are set in Default Job Properties
of Production Manager

Changes in Color Adjustment Curves made in the RIP and Print dialog are now stored to
preferences and inside the .fs file

RIP and Print will now read the default selected label color from Production manager

Production Manager

All Zund ZCC cut types are now supported

Zund ZCC barcode number is now added to the file name for easy visual reference

Fixed an inconsistency of Zund ZCC mark placements between print and cut

The default extension for Zund ZCC files has been changed to .zcc

Fixed an issue when loading grommet settings from presets

Summa barcode and XY lines now extend over all pages of multipage PDF jobs

Nested jobs with both print only jobs and jobs with contour cut paths will now generate the cut
job correctly

Fixed a mismatch between print and cut when the output has many rows of small jobs as well as
cut marks

Fixed a mismatch between preview and output where sometimes the preview would allow more
objects on a row than in output

Output ICC profiles from presets now apply correctly to all sub jobs of nested nobs

The finishing tool preview now have zoom and rulers

Embedded grayscale input ICC profiles now apply correctly

Negative Graphtec marks will now be in the center of the squares



When a default cutter is set in default job properties, registration marks will be skipped for jobs
without contour cut paths

Invalid characters in ICC profile names will be removed automatically in Color Profiler

Variable White in RIP will now be generated by lightness instead of ink density

Color Adjustment curves from presets created in Production Manager are now set loaded
correctly in the RIP and Print dialog

Improved rendering speed of files with spot color gradients

Fixed a crash that might occur in the Cut/Plot dialog with the tile all copies feature when there is
no cut object in the job

When nesting jobs in Production Manager, sub jobs will be rotated automatically to avoid tiling
Advance after plot is now selected automatically when a repeat job is specified

Jobs can now be dragged across different sheets of media on flatbed printers in manual nesting
Fixed an issue with HP Latex Printers synchronizing media containing special characters

Fixed a crash that might occur when closing the Job Properties dialog while the preview is being
generated for textile step and repeat

Renamed options for Graphtec marks. Size has been renamed to total size. This option is for
adjusting extra margins outside the marks. Margin refers to the distance between the corners of
the marks and the job. Length has been renamed to Mark Length

Fixed an issue with opening Driver Properties for the Graphtec GPGL driver

Passmask now applies to spot channels such as white for Roland drivers that support it

Fixed an issue that might cause extra cut lines when the knife offset is not 0

Improved rendering of overprinted spot channels

Moving jobs with presets in non-English locales now works correctly

The automatic tile flip check box has been moved from the preferences dialog to the tiling tab of
Default Job Properties

Fixed an issue with Repeat Job sent to Hybrid devices

Object Color Control now works for PDF files with transparency groups or transparent bitmaps
Fixed an issue where sometimes skipped separations were still printed

Nested jobs now apply the correct media and resolution when Job Properties are different from
Default Job Properties

Fixed an issue that sometimes ink split was applied to ink limit targets when Default Job
Properties had an ICC Profile set

Fixed an issue that when a different color than black was chosen for labels, the preview in
Production Manager would still display it as black

In Job Properties, center on layout is now remembered when changing media size after setting
positioning

Fixed an issue in the Save As dialog in Production Manager that sometimes a change in format
selection was not being applied

The line width of Mutoh AASCII marks has now been changed to 0.1mm for large marks

Fixed an issue with printing separations with spot channels

Fixed a RIP error that might occur when the label color is a spot color that is also used in the
design



Pages of Multipage PDF files are now kept side by side when assigning marks while center
aligned

Job names are no longer truncated in Production Manager if the original .fs file name contains
an extra period

The default value for Ignore Overprint is now unchecked

Fixed a RIP error that might occur with very small gradients

Margin and Border now print correctly on printers with RGB 8 bit color modes

When a mark is changed from margin to other types, the label width is now adjusted accordingly
The job previews in the main window for tiled print and cut jobs now display correctly.

New Printer Drivers

DYSS: DYSS-GH-2200-16SFWFV, DYSS-GF-2613-12FRWRV

Hewlett-Packard: HP Latex 370 Printer, HP Latex 110 Printer

Mimaki : JV300-130, JV300-160, CJV300-130, CJV300-160, JV150-130, JV150-160, CJV150-130,
CJV150-160, CJV150-107, CIV150-75, JFX200-2131, UJV500-160, SIJ-320UV

Mutoh: VJ-628X, VIJ-1628X, VJ-1938WX, VI-1638WXLA

Roland: SOLJET PRO 4 XR-640 C, SOLJET PRO 4 XR-640 WMT, SOLJET PRO 4 XR-640 LkW, SOLJET
PRO 4 XR-640 LkMT, Texart RT-640

SID : SID Triton Series

Titan: TT-4C DYE, TT-4C ECO, TT-6C DYE, TT-6C ECO, TT-6C-2 DYE, TT-6C-2 ECO, TT-8C-LLK, TT-8C-
LY,TT-8C-Textile, TT-8C-WV, TT-Ricoh-4C, TT-Ricoh-6C, TT-Ricoh-Textile, TT-Ricoh-UV,

Xenons 4740TX-8C, Xenons 4740TX-6C, Xenons 4740TX-4C, Xenons RICOH-WV

New Cutter Drivers

AZONColor: CC64w, CC24a, CC48a, CCb4a

Eurosystems: Optiscout

GO: GO MaxCut ARS

Mimaki: CJV300-130, CJV300-160, CJV150-130, CJV150-160, CJV150-107, CIV150-75

Roland: SOLJET PRO 4 XR-640 C, SOLJET PRO 4 XR-640 WMT, SOLJET PRO 4 XR-640 LkW, SOLJET
PRO 4 XR-640 LkMT, GS-24

STM Robotics: STM24, STM48, STM721, STM1351,

SUCHI: SC-730, SC-730E, SC-730S, YX-730L, SC-1300, YX-1300L, SC-1350E, SC-1350S, YX-24L, YX-
48L

Summa : F SERIES (SummaFlex)

Titan: TITAN 3 ARMS
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